The Fading of Bromophenol Blue
Purpose
You have seen in previous experiments the importance of studying the stoichiometry of chemical reactions. However, stoichiometry is only concerned with the initial and final state of the reactants and products, and not concerned how the reaction takes place over time. Explosions occur in a fraction of a second, the corrosion of metals in nature takes years. Chemical kinetics is the branch of Chemistry that building on stoichiometry studies how chemical reactions occur over time and formulates rate equations to describe the temporal behavior of reactions. 
Scenario
Chemical products have to go through rigorous testing before they are approved for public consumption in terms of their shelf-life, and how they behave under different, sometimes adverse conditions (e.g. in environments with different pH, moisture content, temperature), and these characteristics have to meet specific guidelines and have to be well-documented. For example the medicine Levothyroxine, a medication widely used for treating Thyroid disorders, is known to degrade in alkaline environment over time. Testing procedures follow the concertation of either the reactant(s) or the product(s). In case of Levothyroxine High Performance Liquid Chromatography (HPLC) is used to follow the concentrations of the reactant and products. In case either the reactant or one of the products is colorful, visible spectroscopy can be used to follow the change of concentration of the colorful species over time. The model compound, Bromophenol Blue that you will be using is blue and when it is placed into alkaline environment it forms a colorless product. 
Often, already existing testing procedures for a similar product are adopted for two reasons. If a procedure is already well-documented and accepted, its viability doesn’t have to be established and proven. Secondly, typically adoption of a procedure is more cost effective than developing a new one. You will tackle the reaction between Crystal Violet and sodium hydroxide as this reaction has available experimental data and expected to behave similarly than Bromophenol Blue in alkaline conditions. Analyzing the existing experimental data will be the foundation for the reaction that you will perform between Bromophenol Blue and sodium hydroxide       


Pre-Laboratory Assignment
NAME:  _________________________		Due Before Lab Begins
Consider the reaction between Crystal Violet, which is a dye (much like the Bromophenol Blue, which you will be using in this lab), and OH- ions:
[image: Image1]


(a) 
Write the rate law for this reaction. Use “k” for the rate constant. Use “m” and “n” to represent the order of reaction with respect to CV+ and OH-, respectively: 

________________________________________________________
(b) 
In terms of m and n, what is the overall order of the reaction? 
________________________________________________________

When there are multiple reactants in a reaction, it can be difficult to experimentally determine the reaction order of each reactant because both concentrations are changing as a function of time. To simplify the experiment, one reactant can be in extreme excess so that its concentration essentially remains constant during the reaction. Instead of using the rate constant, k, we use a “pseudo rate constant”, k’, which combines both k and the concentration of the reactant which remains constant. Thus, the rate law is written in terms of only one reactant concentration. If OH- is in extreme excess, write the simplified rate law, using the pseudo rate constant, k’, [CV+], and m:
 __________________________________________________________
(c) Write an expression for k’ in terms of k, [OH-], and n:

  ____________________________________________________________
Background
Bromophenol blue, H2Bp, is an organic compound having two acidic protons (H+'s) which are readily abstracted to form a blue dianion, Bp2-.  In this lab, you will be supplied with an aqueous solution of Na2Bp.  The blue dianion, Bp2-, in this aqueous solution reacts with excess hydroxide ion to form a colorless tri-negative ion Bp(OH)3- as shown below.
	[image: reaction of Bp2- with OH-]

	Bp2- (blue)
	 
	Bp(OH)3- (colorless) 


The disappearance of the blue dianion in an excess of hydroxide proceeds at a rate that is easy to monitor as the half-life is on the order of minutes.  The overall rate law that describes this reaction can be written as follows:
	
 
	(2)


where k is the overall rate constant, [Bp2-]   and [OH-]  are the time-dependent concentrations of the bromophenol blue dianion and the hydroxide ion, respectively, m is the order of the reaction with respect to Bp2-, and n the order with respect to OH-. To determine the rate law, the unknowns k, m, and n must be found.
One way to determine the order of a chemical reaction is to monitor the concentration of the reactant(s) versus time.  If a reaction is first order with respect to a particular species, X, then a plot of ln[X] vs. time is linear and the slope of the line is the negative of the rate constant.  If the reaction is second order with respect to X, then a plot of 1/[X] vs. time is linear.  Here, the slope is equal to the rate constant.
In a bimolecular reaction, such as the one above, determining the reaction order with respect to one species can be simplified by choosing reaction conditions in which the concentration of one reactant is so large that it is essentially constant during the course of the reaction.  In determining the rate law for this reaction, the hydroxide ion should be in large excess so that only the concentration of Bp2-  decreases during any one experiment. 
Since Bp2-  is colored, its concentration can easily followed spectrophotometrically.  By monitoring the concentration of Bp2-  in two or more experiments with different concentrations of excess hydroxide, one can determine the order with respect to the [OH-] also.  This permits evaluation of the overall rate law and the rate constant.
You will need to use the spectrum below in order to determine the wavelength at which to set your spectrophotometers:
[image: Bp spectrum]
Figure 1:  Bromophenol blue spectrum 
Procedure
Part I: Formation of Groups 
You will be working in group of two. You should perform two reactions, each with a different (excess) NaOH concentration. Use your prelab and your work from Part II as a guide to determine which concentrations and amounts to use in each solution you make. The initial concentration of Bp2- should be the same for each of your reactions. Be certain to keep the ionic strength, which is related to the total number of ions present in a solution, the same for all trials.  This will be achieved in this experiment by keeping the sum of the [NaOH] and [NaCl] constant.  For example, [NaOH] + [NaCl] = 2.0M.  
Part II: Designing the Experiment – An Alternative Scenario 
1. There were two experiments performed between Crystal Violet (CV+ ) and sodium hydroxide (OH-) and  with the following initial conditions:
	Trial
	[CV+]0
(M)
	[OH-]0
(M)

	1.
	3.0x10-6 
	5.0x10-2 

	2.
	3.0x10-6
	2.5x10-2



(The zero subscript indicates “initial condition”, the concertation before the reaction occurs, but after mixing) 
In both trials [OH-] is not changing measurably during the reaction. However, the absorbance of [CV+] is measured as a function of time and converted to concentration values using Beer’s Law ([CV+]=A/l), and the concentration values are listed in an Excel spreadsheet which can be found on BlackBoard.
Depending on the order of CV+ in the reaction (m), the concentration of CV+ changes with time differently, however m can be determined from the graphical representation of the [CV+] over time data as follows:

	m
	Rate
	Integrated rate law
	Plot

	0
	Rate=k’
	Rate is independent of [CV+]
	[CV] vs. t

	1
	Rate=k’[CV+]
	


	


	2
	Rate=k’[CV+]2
	

	




(a) Using Excel and the directions below, determine the order of the reaction with respect to [CV+].
· Open the provided Excel file.
· Complete the two columns to the right of the data for Trial 1 labelled “ln [CV+]” and “1/[CV+]”, respectively by adding the respective formulae (ln([CV+] and 1/[CV+])
· In cell C3 enter the formula: =ln(B3)
· Copy this cell into the remaining of column C
· In cell D3 enter the formula =1/B3
· Copy this cell into the remaining of column D
· Repeat the same for columns F and G using the values from column E for the concentrations for Trial 2
· Now make three plots from the data of Trial 1 onto the yellow areas: 
1. [CV+] as a function of time
2. ln [CV+] as a function of time 
3. 1/[ CV+] as a function of time
Hint: to highlight two non-adjacent columns in Excel for plotting follow these steps:
· Highlight cell A3 (first time point)
· Hold down the Shift and Ctrl keys, and press the Down Arrow key (this will highlight all the data in column A). Let the keys go
· Scroll up while column A remains highlighted
· While holding down the Ctrl key, and click on cell C3
· While holding down the Shift and Ctrl key, press the Down Arrow key. This will highlight the rest of the data in column C
· From the Insert menu insert a scatter plot
· Insert a linear trendline for each of the three plots.  Include the equation and the R2 on each plot.  
· Choose the representation (1,2, or 3 from the list above) that has the most linear relationship (R2 closest to 1).  The most linear dependence determines the order of the reaction with respect to [CV+]: 
· zero order ([CV+] as a function of time most linear)
· first order (ln [CV+] as a function of time most linear) 
· second order (1/[ CV+] as a function of time most linear)
· Collect the correlation coefficients in the table below from the graphs
	m
	Plot
	Correlation coefficient

	0
	[CV] vs. t
	

	1
	

	

	2
	

	


Order of reaction with respect to [CV+]: __m = 1_____

(b) Now that you have determined the order of the reaction with respect to [CV+], you know which plot will be linear for Trial 2. Add this graph to the plot of the data of Trial 1, including the equation and R2, and attach it to this pre-lab. 
Hint: to add data to one of the three graphs follow these steps:
· Click on one of the data points, then right click to bring up the context menu
· Select Select Data
· Click on the Add button
· Click on the spreadsheet icon in the end of the Select X values line
· Highlight the time values in column A and click on the spreadsheet icon again 
· Click on the spreadsheet icon in the end of the Select Y values line
· Highlight the time values in the column that you wish to plot (E, F, or G) and click on the spreadsheet icon again
This plot now should have two sets of data (one for each Trial) with the representation that is most linear and the respective equations (with the R2 values). 
[image: ]


Just like the rate constant is the absolute value of the slope of the most linear plot for a one-reactant reaction, k’ is the absolute value of the slope of the most linear plot for a reaction with one reactant in large excess. Report your k’ values for each trial, including appropriate units of time (rate has units of  or M/s):
	Trial 1, k’ = ______6.65x10-3  s-1________
	Trial 2, k’ = ______3.33x10-3  s-1________		
(c) Using your calculated values of k’ and your expression for k’ in terms of k, [OH-], and n; solve for n, the order of the reaction with respect to  [OH-]. Show your work here:



 	n = _1______________
(d) Solve for k. Include appropriate units of time. k = __0.13 M-1s-1____________
(e) Finally, write out the rate law including numerical values for k, m, and n (include units for then rate constant):

	    _______________________________________________ __________________
2. In this lab, you will be reacting Bromophenol Blue (Bp2-) with NaOH. NaOH will be in extreme excess. You will be measuring the concentration of Bp2- as a function of time and using plots to determine the order with respect to Bp2-. Bp2- is blue in color, but when it combines with NaOH, the products are colorless. The solution appears to fade with time. You will be measuring [Bp2-] spectroscopically: absorbance as a function of time. Because Bp2- begins to react immediately, as soon as you make your solution you no longer know the concentration of Bp2- in solution. Therefore, it is not necessary to use volumetric glassware to measure Bp2-. However, the ratio of NaOH concentrations for your two trials is very important to your calculations, so you must use volumetric glassware to measure NaOH. Use the solutions given in the Materials and Equipment list (shown on the next page) to create the solutions you will need for your experiment. Show all calculations. 

Materials and Equipment Provided
· 4 M NaCl
· 4 M NaOH
· 0.4 g/L bromophenol blue (Na2Bp = Na2C19O5Br4SH8) 
· 50.00 mL and 100.00 mL volumetric flasks
· Volumetric/graduated pipettes
· Graduated cylinders
· Computers with Logger Pro software and colorimeters.

(a) Describe how you would prepare 50.00 mL of a solution that is 0.02 g/L  Bromophenol Blue in 2.00 M NaOH. Convert the Bromophenol Blue concentration to M (FW = 714 g/mol). Show all calculations below the table. Consider, that the higher the concentration of the reactants when you mix them, the faster the reaction starts, the more you miss before you start the data collection. Therefore, when you make the solution in your strategy you want to dilute one reactant as much as you can before adding the second reactant (use as many entries in the table as you need).  

Glassware used for the 50.00 mL solution: _50-mL volumetric flask_________



	Step
	Added solution/water
w/conc.
	Volume of added solution/water
(or indicate to fill to the mark if applicable)
	Glassware used
	Final conc. after dilution to 50.00 mL

	1
	4.00 M NaOH
	25.0 mL
	Volumetric pipet
	2.00 M

	2
	water
	20 mL
	50 mL grad. cylinder
	N/A

	3
	0.4 g/L Bp
	2.00 mL
	2-mL pipet
	0.02 g/L, 2.8x10-5M

	4
	water
	Fill to mark
	N/A
	N/A

	5
	
	
	
	




(b) Describe how you would prepare 50.00 mL of a solution that is 0.02 g/L  Bromophenol Blue in 1.00 M NaOH and 1.00M NaCl (so the total ion concetration will be the same as previously). Convert the Bromophenol Blue concentration to M (FW = 714 g/mol). Show all calculations below the table. 

Glassware used for the 50.00 mL solution: _50-mL volumetric flask_________



	Step
	Added solution/water
w/conc.
	Volume of added solution/water
(or indicate to fill to the mark if applicable)
	Glassware used
	Final conc. after dilution to 50.00 mL

	1
	4.00 M NaOH
	12.5 mL
	25-mL graduated pipet
	1.00 M

	2
	4.00 M NaCl
	12.5 mL
	25-mL graduated pipet
	1.00 M

	3
	water
	20 mL
	50 mL grad. cylinder
	N/A

	4
	0.4 g/L Bp
	2.50 mL
	5-mL graduated pipet
	0.02 g/L, 2.8x10-5M

	5
	water
	Fill to mark
	N/A
	N/A







Part III: Performing the Experiments
We will be using computerized data collection for this lab that consists of a LabQuest 2 data collection device and a SpectroVis spectrophotometer attached to the LabQuest 2. 
1. From the file menu load the “BP_kinetics.qmbl” setup file
2. Calibrate the SpectroVis by following the information provided at your station.
3. Combine all the components of your reaction mixture, leaving the Bp last. After adding the Bp solution fill the volumetric flask, and mix the solution. 
4. Quickly pour some of the mixture into a small beaker, and transfer some of the solution into a cuvette, and place the cuvette into the spectrophotometer
5. Start the data collection.
6. Stop the data collection when the absorbance drops below 0.1
7. Click on the file cabinet icon to save your data
8. Repeat the same steps for the second trial
9. Transfer your data into a blank Excel file by following the steps for one of the methods below. Copy the data from the newly created Excel file into the appropriate columns of the “Bromophenol Blue data” spreadsheet of the Excel file that you used for the pre-lab work. 
	Exporting the Data for Excel

	1. Plug in your USB drive into the USB Type A port
2. Select File > Export.
	[image: ]

	1. Click on the USB icon, and change the default Untitled name.
2. Click Save.
3. If you previously saved your spectrum, load it into the LabQuest (File > Open), and save it the same way as before on the USB drive.
	[image: ]

	4. Plug your flash drive into the computer 
5. Start Excel and select File > Open.
6. Change the file filter to Text Files, and locate your file
	[image: ]

	7. Complete the Import Wizard with the default settings.
	[image: ]

	Saving data on a Smartphone or on a Computer

	1. Tap on the  [image: ] icon and locate the IP address of the device.
2. Open a browser window on your phone or computer, and navigate to the IP address of the device
	[image: ]

	3. Click on the [image: ] icon on the top right, and select Download data to download your results in .CSV file or right into Excel.
	[image: ]







Report

1. Copy your raw data from the Excel file that you created into the “Bromophenol Blue data” worksheet in the same Excel file that you used for Part I, one column at a time.
Hint: when you paste your data, highlight the data in one column, copy it to the clipboard (Ctrl-C), highlight the first data cell in the destination column, from the menu select Paste/Paste Special/Values. This way you preserve the formatting.
2. Make the plots for Trial 1, and use these to determine the order of reaction with respect to Bp2+ (A vs. time, lnA vs. time and 1/A vs. time). You may use absorbance in place of concentration. If your first data point doesn’t look right, delete it before plotting. For Trial 2, just make the plot that was most linear for Trial 1. Include your four plots to your results in your report. 
Hint: Paste your graphs into your report as an image rather than just using Copy-and-Paste (e.g. Paste/Paste Special/JPEG).

3. What are the values of k, m, and n for this reaction? Round n to the nearest integer. Include units where necessary. Show your work.

	k
	1.43x10-3 M-1s-1

	m
	1

	n
	1



[bookmark: _GoBack]
4. What is the overall rate law for this reaction (include the value of the rate constant with the appropriate units in your rate law)? The overall order?



Overall rate law __________________________________

Overall order _____m+n=1+1=2_________________        

5. Compare the molarity of Bromophenol Blue and NaOH in each experiment/trial (the concentration of Bp is given in g/L, however the formula weight of Na2Bp is given in the Materials section of the lab manual to help you convert the g/L to moles/L): 
(a) Why is one so much greater than the other?
[OH-] is much higher to establish pseudo-conditions, that is conditions where the concentration of one of the reactants is not changing appreciably 


(b) Why is such a small concentration of Bp2- used?
The absorbance initially close to 1.5, therefore higher concertation would yield to high absorbance to be able to measure



(Note: The answer is not the same for both of these questions.)
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